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1. Uvod 

Moderna nastava podrazumeva primenu modernih nastavnih sredstava i metoda nastave. U izobilju 
modernih nastavnih sredstava koja pobuđuju audiovizuelnu percepciju učenika vodeću ulogu 
svakako imaju digitalni nastavni materijali.  

 

Primena digitalnih nastavnih materijala u nastavi 
pruža velike mogućnosti i njihova uloga u nastavi je 
višestruka. Njihova primena u podučavanju 
omogućava nastavniku da ispolji viši nivo 
inventivnosti i kreativnosti. Osim toga, digitalni 
nastavni materijali predstavljaju idealan način za 
aktivno uključivanje samih učenika u nastavni 
proces i razvoj partnerskog odnosa između učenika 
i nastavnika. 

 

Izrada digitalnih nastavnih materijala, najčešće filmova, nije 
više samo posao za profesionalce, već je postala dostupna i 
običnim ljudima. Samo neke od prednosti digitalnih nastavnih 
materijala u odnosu na klasične su veći izbor atraktivnih 
nastavnih sadržaja, dostupnost, višestruka iskoristivost i 
ušteda vremena.  

Internet, kao sredstvo masovnog komuniciranja, daje 
mogućnost stvaranja baza digitalnih nastavnih materijala koje 
se neprekidno dopunjuju. Njihova najveća prednost je 
mogućnost pretraživanja po različitim kriterijima. 

 

U mnoštvu alata za rad sa audio i video materijalom možemo 
izdvojiti Audacity i Windows Movie Maker koji su vrlo jednostavni 
za učenje i korišćenje u učionici, kako za pravljenje učeničkih i 
nastaničkih projekata u formi kratkog digitalnog filma i njihovo 
objavljivanje na internetu.  

 Pored personalnog računara sa operativnim sistemom Windows  
sa mikrofonom i zvučnicima, za snimanje videa i njegovo 
objavljivanje na nekom od sajtova, potreban je jednostavni 
digitalni fotoaparat, digitalna video ili veb kamera.  
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2. Film i internet kao sredstva komunikacije 

2.1 Korisnici interneta kao kreatori filmova 

Moderna komunikacija podrazumeva pre svega 
korišćenje savremenih sredstava komunikacije, kao 
što su film, televizija, računari i internet. U vreme 
kada posedovanje prave informacije predstavlja 
najveću snagu i ekonomsku moć, Internet nam 
pruža mogućnost novog načina razmenjivanja 
informacija, za sada najbrži mogući, koji donosi 
jedan novi vid i kvalitet u odnosu na ostala sredstva 
informisanja.  

Sa postankom društvenih mreža više nego ikad je izražena moć povezivanja ljudi i znanja preko 
interneta. Neformalna osobina interneta i brz pristup neograničenim količinama informacija u vidu 
multimedijalnih sadržaja sa bilo kog kraja sveta omogućava sticanje znanja koje formalno 
obrazovanje ne pruža.  

Medijsko obrazovanje i medijska kultura postaju neophodni u cilju razvijanja kritičkog i stvaralačkog 
mišljenja svakog aktivnog člana zajednice.  

Uključivanje „običnih ljudi“, korisnika interneta u kreiranje medijskih sadržaja i pojava društvenih 
mreža dalo je internetu jednu potpuno novu dimenziju. Društvene mreže su dale tu mogućnost da 
bilo koji korisnik objavljuje tekstualni, audio i video materijal, koji može da pogleda i pri tome oceni 
ili prokomentariše veliki broj ljudi. Izvori sa društvenih mreža u velikom broju slučajeva su primarni 
izvori informacija tj. akteri ili svedoci događaja. Međutim, veliki broj podataka i informacija na vebu 
se ne mogu uzeti kao verodostojan i proverljiv sadržaj.  

 

2. 2 Film kao obrazovno nastavno sredstvo 

 Digitalni filmovi pred nastavnika postavljaju nove metodičke 
zahteve. Ukoliko koristi gotov film, nastavnik ne sme film 
prikazati pre nego što ga on sam pregleda i analizira njegove 
mogućnosti za nastavni rad. Kada nastavnik odabere film koji će 
prikazati mora da napravi plan njegovog prikazivanja. Dobar 
obrazovni film prikazan u pravo vreme ima veliku obrazovnu i 
vaspitnu vrednost, obogaćuje i kontekstualizuje nastavu, čini je 
zanimljivijom i raznovrsnijom, a stečena znanja učenika 
trajnijim.  

Pre prikazivanja filma potrebno je izvršiti pripremu učenika za gledanje filma. Svaki komentar 
nastavnika tokom gledanja filma može da ometa zapažanja učenika. Zato je pre puštanja filma 
potrebno naglasiti učenicima na koje delove filma posebno da obrate pažnju. Nekad je poželjno da se 
učenicima film prikaže više puta.  

Veoma je važno da u zavisnosti od konkretne nastavne situacije, nastavnik napravi pravi izbor i 
prirodnu i logičnu kombinaciju nastavnih metoda u skladu sa kojima prikazuje film u adekvatnom 
kontekstu. Digitalni film se može prikazivati u uvodnom delu časa kao priprema učenika za novu 
nastavnu temu ili jedinicu. U tom slučaju film ne bi trebalo da traje duže od pet minuta.  
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U glavnom delu časa digitalni filmovi mogu biti glavno ili pomoćno nastavno sredstvo. Kada digitalni 
film predstavlja glavno nastavno sredstvo njegova dužina se kreće oko 15-ak minuta. U glavnom delu 
časa digitalni film može da predstavlja pomoćno nastavno sredstvo za posredno prikazivanje ogleda 
ili situacije koji traje nekoliko minuta. U završnom delu časa se može prikazati digitalni film kao 
rekapitulacija izložene nastavne teme ili jedinice.  

Pošto se reprodukuje na kućnom računaru i lako se umnožava, za razliku od 
klasičnog filma, izborom digitalnog filma koji dopunjava nastavu može se vršiti 
i individualizacija nastave. Za različite nivoe znanja i različita interesovanja 
učenika moguće je izabrati različite filmove (koji će biti uvod u proučavanje 
gradiva ili zadnji korak pred zaključak u procesu ovladavanja novim gradivom) 
pa im omogućiti da u školi ili kod kuće pogledaju ove filmove.  

Prilikom izbora digitalnog filma treba voditi računa o uzrastu učenika kojima se prikazuje i njegovim 
psihofizičkim sposobnostima. Mlađem uzrastu treba prikazivati filmove sa manjim brojem detalja i 
efekata. Ako film koji izaberemo nije prilagođen uzrastu učenika neće imati punu vaspitno obrazovnu 
funkciju. 

Upotreba digitalnih filmova u nastavi treba da ima sledeće ciljeve: 

 Povećanje motivacije učenika za učenje i razvijanje interesovanja za nastavu 
(prikazivanjem filmova prilagođenih temi časa, predznanju, interesovanjima i uzrastu 
učenika);; 

 Podsticanje učenika da uočava, zapaža, razume, uočava odnose i situacije koje je 
video reprodukovane na filmu (prepoznavanje i analiza situacije); 

 Podsticanje učenika da usvoji i koristi podatke i principe koji su mu izloženi. 
Povezivanje nastavnih tema sa realnim situacijama prikazivanjem pažljivo odabranih 
filmova (kontekstualizacija znanja);  

 Podsticanje učenika da vrednuju, kritikuju i iznesu svoj sud o onome što vide na filmu 
(formiranje sopstvenog mišljenja, argumentacija i diskusija); 

 Razvijanje mašte i interesovanja kod učenika, učenik se podstiče da procenjuje, 
klasifikuje, predviđa i pretpostavlja (razvijanje kritičkog i apstraktnog mišljenja); 

 Osposobljavanje učenika da reformuliše, rezimira i sintetizuje saznanja dobijena 
gledanjem filma. Osposobljavanje učenika da samostalno gradi i primeni svoja znanja na 
osnovu filma, npr. kroz samostalne filmske projekte. 

Različiti su izvori filmova za nastavu – to može biti obrazovni film koji se kupuje namenski pravljen za 
datu temu u okviru plana i programa nastave, odgovarajući filmski materijal legalno preuzet sa 
kablovske televizije, TV-a ili interneta, ili se može čak napraviti od strane nastavnika, ili od učenika u 
saradnji sa nastavnicima, ili filmski materijal koji su snimili i od njega napravili film sami nastavnici i 
učenici. Film preuzet sa interneta se može prikazati u celosti, samo u delu ili montiran od strane 
nastavnika od različitih delova. 
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Za prikazivanje filma na času potreban je samo računar sa video-bimom i ozvučenjem pri frontalnoj 
nastavi, dok je za individualnu nastavu potrebno da svaki učenik ima svoj računar sa monitorom i 
slušalicama. 

2. 3 Film kao sredstvo očuvanja kulturne baštine jednog kraja 

Film je, kao što smo već rekli, snažno sredstvo komunikacije. Zato se u raznim globalnim projektima 
koji treba da podignu svest običnih ljudi o važnosti jedne teme, uvek prvo bira film kao efektan način 
za davanje poruke, formiranje mišljenja članova jedne zajednice i edukaciju za dalje individualne 
aktivnosti. Kada je reč o očuvanju kulturne baštine, koja je tema mnogih svetskih pokreta, mnogo je 
sadržaja iz društvenih i prirodnih nauka koji se mogu predstaviti digitalnim filmom: 

 U okviru nastave iz društvenih nauka mogu se napraviti filmovi koji predstavljaju 
realne ili hipotetične životne situacije, koje su karakteristične za običaje tog kraja; 

 U nastavi stranog jezika korisni su filmovi koji pokazuju različitost dijalekata i govora 
pojedinih grupacija u okviru zajednice;  

 Za istoriju i proučavanje prošlosti korisno je pokazati postavke iz nekog istorijskog ili 
etnografskog muzeja iz sopstvenog kraja, a razmena filmova koji su napravili sami nastavnici u 
lokalnim muzejima je dragocen resurs obrazovnih filmova za nastavu istorije. 

 U nastavi maternjeg ili stranog jezika film može da predstavlja dramatizaciju nekog 
odlomka književnog dela autora koji je potekao iz kraja u kome autori filma žive, koja od male 
pozorišne predstave, uz dobru montažu, postaje pravi igrani film. 

 U nastavi geografije može da se napravi digitalni film panorame kraja i da se na 
osnovu napravljenih snimaka dodatno napravi mapa terena, uradi tumačenje u odnosu na 
geografske karte i satelitske snimke. 
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3. Rad sa audio datotekama u programu Audacity  

 

3.1. Radna površina programa Audacity 

Postoji mnogo softvera za editovanje audio  datoteka, ali najčešće nisu besplatni tako da ih većina 
korisnika ne može koristiti sa svoje potrebe. Na sreću, program Audacity predstavlja besplatnu open 
source platformu za obradu audio datoteka i može se preuzeti sa sajta 
http://audacity.sourceforge.net/. Ovaj program spada u jednostavnije sa osnovnim opcijama i 
alatima, ali je potpuno besplatan i njegove nove verzije se neprekidno dorađuju. 
 
Kada pokrenete program Audacity, otvoriće se radna površina (Slika 1). Sve što kreirate u ovom 
programu prikazuje se kao projekat na dnu radne površine. Kombinacijom tastera CTRL+F možete 
videti celi projekat. 
 

. 

 

 

 

 

 

 

 

 

 

 

Slika 1 

Kliknite na Edit→Preferences, a zatim na Quality tab. Selektujte 44100 Hz kao podrazumevanu 
(default) brzinu semplovanja, i 16-bit kao podrazumevani format. Ovakva podešavanja se rade samo 
jednom. Na kraju, kliknite OK da zatvorite dijaloški prozor (Slika 2).  

 

 

 

 

 

 

 

 

 

Slika 2 
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Da biste importovali (uvezli) audio datoteku u vaš Audacity projekat, kliknite na 
File→Import→Audio, odaberite lokaciju vaše .wav ili mp3 datoteke i kliknite Open. Možete videti 
datoteku  predstavljenu kao zvučni zapis (Slika 3 i Slika 4). 

 

Slika 3 
 

 

 

 

 

 

 

 

 

 

Slika 4 
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3.2. Krajnji levi meni 

 

 
Slika 6 

Možete podesiti visinu trake zapisa pomeranjem kursora na donjoj ivici trake dok se ne promeni u 
dve vertikalne strele. Visinu trake podešavate pomeranjem ivice vertikalno (Slika 7). 

 

Slika 7 

Možete promeniti naziv zapisa klikom na padajući meni u levom meniju, selektovanjem opcije Name. 
U dijalogu Track Name otkucajte željeni naziv i kliknite OK (Slika 8). 
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Slika 8 
Preslušajte audio datoteku klikom na Play dugme (ili možete pritisnuti spacebar, što je prečica sa 

tastature za Play i Stop dugmad. Osnovna dugmad za rad sa datotekom su prikazana na slici (Slika 9): 

 

Slika 9 

3.3. Osnovne alatke za rad sa audio snimkom 

Ako želite da preslušate bilo koji deo  datoteke, mora biti aktivna opcija selection tool (prečica sa 
tastature je F1) (Slika 10). 

 

Slika 10 
 
Kiliknite bilo gde na traku zapisa da pozicionirate playback kursor, i kliknite spacebar za puštanje 
zapisa (ili jednostavno kliknite na Play dugme). 
 

Obrada snimka obično počinje uklanjanjem dela snimka koji vam nije potreban. Ako ste importovali 

audio snimak ljudskog govora, jedan primer bi bio uklanjanje dela snimka koji predstavlja kašalj. Da 

biste ovo efektno uradili, potrebno je uvećati taj deo datoteke korišćenjem alatke zoom tool.  
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Kliknite na zoom tool dugme da biste ga aktivirali (ili koristite prečicu sa tastature F4) (Slika 11). 

Kursor će dobiti izgled crne lupe. 

 

Slika 11 

Sa aktiviranom opcijom zoom tool, selektujte opseg datoteke koji sadrži kašalj klikom i povlačenjem 
po opsegu. Ivice selektovanog opega su označene vertikalnim isprekidanim linijama i kada otpustite 
levi taster miša, datoteka će biti zumirana. (Slika 12). 

 

Slika 12 

Aktivirajte selection tool (F1), zatim selektujte tačan opseg koji sadrži kašalj klikom i povlačenjem po 
opsegu. Možete podesiti slektovani opseg prelaskom kursorom preko leve ili desne ivice 
selektovanog opsega dok kursor dobije oblik ruke koja pokazuje. Klikom i povlačenjem dovedite 
selektovani opseg do željenog (Slika 13). 

 

Slika 13 
Kada smo locirali i selektovali kašalj, možemo da ga odstranimo klikom na Delete taster. Ovo se 
takođe može postići biranjem opcije Edit→Remove Audio or Labels→Cut (ovim postavljamo 
selektovani opseg u clipboard i možemo ga kasnije iskoristiti). 
 
Da biste se uverili da kašalj više nije u snimku, postavite kursor pre tačke editovanja, kliknite na play 
dugme.  
 
Zumirajte sve do kraja da biste videli ceo zapis klikom na opciju Fit Project in Window (prečica sa 
tastature je Ctrl+F) (Slika 14). 
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Slika 14 
 
U slučaju da zapis govora ima značajnu količinu tišine, ti delovi se mogu odseći iz audio zapisa. 
Selektujte opseg audio zapisa koji želite da sačuvate (koristite selection tool, F1). Klikom na opciju 
Trim audio (or Ctrl+T) odseca se deo audio datoteke van selektovanog opsega (Slika 15). 
 

 

Slika 15 
 

Bez odsečeneg dela audio datoteka igleda ovako (Slika 16). 

 

Slika 16 
 

3.4. Čuvanje projekta u programu Audacity 

Ako želite da sačuvate projekat kliknite na File→Save Project As, i projekat se čuva kao datoteka sa 
ekstenzijom .aup. Pri samom čuvanju projekta otvara vam se dijalog-upozorenje koje objašnjava da 
se projekat čuva u datoteci specifičnom za program Audacity. Takođe se preporučuje i način čuvanja 
projekta, koji će moći da otvore i drugi programi za rad sa audio datotekama (Slika 17). 

 

 

Slika 17 
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Po podrazumevanom (default) Audacity čuva projekat u direktorijumu odakle je importovana prva 
audio datoteka na kome ste radili. Naravno, lokaciju možete promeniti prema svojim potrebama. 
Svaki sledeći put dovoljno je da kliknete na opciju File→Save.  
Primetićete da sam Audacity program, pri čuvanju projekta, dodaje direktorijum sa imenom koje 
sadrži ime projekta i dodatak _data, u kome se nalaze sve informacije o projektu. 
 
Projekat datoteka .aup sadrži sve detalje koji su za projekat vezani i ne sadrži zvuk, pa prema tome je 
datoteka i vrlo male veličine. Kasnije, kada zatvorite Audacity program i ponovo otvorite samo .aup 
datoteku Audacity automatski preuzima sve audio datoteke koji su vezani za projekat, kao i sve 
promene i podešavanja koje ste uradili na zapisu. 
 
Ako želite da dodate novu audio datoteku u projekat kliknite na File→Import→Audio i odaberite 
željenu datoteku i kliknite Open. U novoj traci zapisa vašeg projekta biće još jedan audio zapis. 
Podesite visinu traka tako da ih možete videti u jednom prozoru (Slika 18). 
 

 

Slika 18 
 
Ako želimo da prvi audio zapis počne sa malim zaakašnjenjem u odnosu na drugi, prvo možemo da 
“isečemo” deo drugog audio zapisa koji nam ne treba. Narvno, prvo koristimo zoom tool, onda 
selection tool, i na kraju brišemo taj deo drugog audio zapisa za koji smo uvereni da nam ne treba 
(Delete taster ili Edit→Remove Audio or Labels→Cut) (Slika 19). 
 

 

Slika 19 
 
Na kraju poslušajte oba audio snimka zajedno. Podesite mesto prvog audio zapisa klikom na opciju 
Time Shift Tool. Zapažite da se oblik kursora menja u duplu strelicu (Slika 20) kada se ova opcija 
aktivira možete da pomerate prvi audio zapis u odnosu na drugi (Slika 21). 
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Slika 20 
 

 

Slika 21 
Ako drugi audio zapis nadglašava prvi, a želite suprotan efekat, potrebno je da se drugi audio zapis 
postepeno utišava do krajnje tišine. Kliknite na Envelope tool opciju (Slika 22). 
 

 

Slika 22 
 
Korišćenjem ove opcije moći ćete da podesite jačinu zvuka oba zapisa. Kada je Envelope tool 
aktiviran, kursor menja oblik u dva simetrična trougla. 
 

 

Slika 23 
 
Kada je Envelope tool aktiviran, možete videti horizontalne linije na vrhu i dnu traka oba audio 
zapisa. Ovako je grafički predstavljena jačina zvuka oba audio zapisa (Slika 23). 
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Ukoliko je cilj da se podesi jačina zvuka drugog audio zapisa u korist prvog, kliknete nekoliko puta na 
liniju koja predstavlja jačinu zvuka drugog audio zapisa da biste postavili kontrolne tačke. Zatim 
pomerate kursorom te kontrolne tačke, slušate objedinjene zapise i pomerate dalje kontolne tačke 
sve dok ne podesite odnos jačina zvuka prvog i drugog audio zapisa (Slika 24). 
 

 

Slika 24 
 
Da biste uklonili kontrolne tačke, jednostavno ih prevlačenjem prema krajnjim linijama uklonite sa 
trake audio zapisa. Kada se radi o stereo traci, morate da podešavate samo levi ili desni kanal i 
promene se odmah reflektuju na drugu stranu. 
 
Ako želimo da drugi audio zapis na kraju utišamo u potpunosti, koristimo tehnike opisane u 
prethodnom koraku, dodavanjem kontolnih tačaka i povlačenjem do jačine zvuka koji je ravan nuli. 
Ovaj proces zahteva više podešavanja i preslušavanja u toku samih koraka da bi se došlo do željenog 
cilja (Slika 25). 
 

 

Slika 25 
 
Da biste videli oba audio zapisa u celosti, kliknite na opciju Fit Project in Window (prečica sa 
tastature je Ctrl+F) (Slika 26). 
 

 
Slika 26 
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Dobija se se objedinjeni zapis, grafički predstavljen na slici (Slika 27). 

 

Slika 27 

U ovom slučaju veliki deo objedinjenog zapisa predstavlja tišinu. Ako ovaj deo koji predstavlja tišinu 
želite da odsečete, kliknite na opciju Fit Project in Window. Objedinjeni zapis će izgledati kao na slici 
(Slika 28). 
 

 
Slika 28 

Na kraju, postavimo objedinjeni zapis da kreće od nule. Korišćenjem SHIFT tastera i selektovanjem 
obe trake, one postaju aktivne. Selektovanjem, obe trake zapisa postaju tamnije. Kliknite 
Tracks→Align Tracks→Start to Zero (Slika 29). 
 
 
 

 

 

 

 

 

 

 

Slika 29 
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Podešavamo sve aktivne trake kao objedinjene, pri čemu traka zapisa koja je u levom delu prozora (u 
ovom slučaju traka drugog zapisa) počinje od nule. Konačno kreiramo jednu datoteku od oba 
objedinjena zapisa, koje smo do sada menjali i podešavali. Pre ovog konačnog koraka, sačuvajte svoj 
projekat još jednom. 

 

3.5. Eksportovanje (Izvoz) objedinjenog zapisa 

Da biste kreirali miksovanu (objedinjenu) datoteku, kliknite na File→Export. U dijaloškom prozoru 
birate željeni direktorijum. Audacity vam podrazumevano nudi direktorijum u kome ste sačuvali prvu 
.aup datoteku. Možete da primetite da vam se kao prva opcija za čuvanje projekta (polje Save as 
type) nudi WAV signed PCM datoteka. U polju File name možete odabrati drugo ime za vaš projekat. 
Na kraju kliknite na Save (Slika 30). 

 

Slika 30 

 
Pri samom eksportovanju projekta, Audacity vam daje obaveštenje o tome da ste ovim korakom od 
dva zapisa napravili jedan u obliku dva stereo kanala, kliknite OK (Slika 31).  
 

 

Slika 31 
 
 
Takođe, u novom dijaloškom prozoru možete dodati nove informacije ili izmeniti stare pomoću 
dugmadi Add, Remove i Clear (Slika 32). 
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Slika 32 
 
Kada Audacity kreira .wav datoteku, nećete primetiti nikakve promene u radnom prozoru. To je zato 
što se eksportovana datoteka nalazi u željenom direktorijumu i bez posebnog naglašavanja programu 
Audacity da ga uključi u sadašnji projekat. Kada je datoteka već kreirana vi ga možete uključiti u 
projekat. 

 

3.6. Korisne dodatne alatke programa 

Cut, copy i paste – ove opcije rade kao i kod tekst procesora. Selektujte neki audio zapis ili njegov 
deo, kopirajte ga ili isecite (copy ili cut), pomerite kursor na drugu lokaciju i nalepite (paste). 
 

 
 
Label tracks – ove opcije vam omogućavaju da beležite datoteku, ili drugim rečima, da označite 
lokacije na traci za dalje korišćenje. One su od velike pomoći, kada želite da označite neka mesta za 
dalje korišćenje. Ovakva mesta kreirate izborom Tracks→Add New→ Label Track. 
 

Splitting – Ova opcija omogućava da se deo zapisa “iseče“ i prenese u novi zapis ostavljajući tišinu u 
delu prvog audio zapisa gde je isečen. Selektujte deo audio zapisa koristeći selection tool (F1) i 
kliknite na opciju Edit→Remove Audio or Labels→Split Cut. Ukoliko želite da taj deo audio zapisa 
izbrišete i više ga ne koristite ni u jednom zapisu, izaberite Edit→Remove Audio or Labels→Split 
Delete. Kreira se nov audio zapis, koji možete nalepiti u bilo koji drugi zapis opcijom Edit→Paste. 
 
Keyboard shortcuts – Kao i u svakom editoru najbrži način rada predstavlja korišćenje prečica sa 
tastature. Audacity vam dozvoljava da uredite svoje prečice za svaku od opcija. Da biste ovo uradili 
izaberite Edit→Preferences pa onda Keyboard tab. Korišćenjem dugmadi Set i Clear podesite svoje 
prečice. 
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Slika 33 
Help – Kao pomoć korisnicima programa Audacity postoji Help→Online Help, sa korisnim savetima o 
opcijama i alatima u editoru. 
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4. Kreiranje filma sa određenom temom u programu Movie Maker 

 

 

 

4.1. Pokretanje i izgled prozora Movie Makera 

Sa operativnim sistemom Windows 7 i programom Movie Maker, lakše je nego ikad da napravite 
svoj film i da ga delite sa drugima. Program Movie Maker nije obuhvaćen operativnim sistemom 
Windows 7, on je deo softverskog paketa Windows Essentials, koji uključuje i alate za rad sa 

fotografijama, slanje poruka, mejlova, društvene mreže itd. Obrada filmova u programu Movie 
Maker je jednostavna kao nizanje scena, fotografija i pokreta gde god želite. Možete koristiti i opciju 
AutoMovie u kome program Movie Maker pravi film za vas. U nekoliko koraka, možete deliti svoje 
filmove na kanalima društvenih mreža YouTube i Facebook ili ih postavite na Skydrive . Možete 
gledati svoj film zajedno sa prijateljima dok četujete na Windows Live Messenger-u. 

Za pokretanje programa potrebno je da kliknemo na Start dugme i iz podmenija All Programs 
izaberemo Movie Maker (Slika 1). 

 

Slika 1 
 
Da biste saznali da li je program Movie Maker već instaliran na vašem kompjuteru, kliknite na dugme 

Start , otkucajte movie maker u search boksu, i vidite da li se pojavljuje u listi rezultata. Otvara se 

radni prozor programa (Slika 2). 

http://windows.microsoft.com/en-us/windows-live/movie-maker
http://windows.microsoft.com/en-us/windows-live/movie-maker
http://windows.microsoft.com/en-us/windows-live/movie-maker
http://windows.microsoft.com/en-us/skydrive/download
http://windows.microsoft.com/en-us/windows-live/movie-maker
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Slika 2 

 

U radnom prozoru ispod linije zaglavlja, desno od ikonice za padajući meni  je glavna linija 
menija (Slika 3).  

 

Slika 3 

 

Klikom na svaki od ovih menija otvara se linija sa alatima, kojima možete otvoriti postojeći projekat, 
ili započeti novi, ili uvesti (importovati) fotografije sa uređaja kao što je kamera, ili sačuvati postojeći 
projekat. Takođe možete sačuvati ili editovati film spreman za gledanje, koristeći media player. 
 

4.2  Datoteke u programu Movie Maker 

Sledeće tipove audio, video i grafičkih datoteka možete da dodate u Movie Maker. 

 

Datoteke sa projektima 

Tipovi (formati) datoteka sa projektima Oznake tipa datoteke 

Windows Movie Maker datoteke sa projektima .mswmm 

Movie Maker datoteke sa projektima .wlmp 

 

 

 

 

http://windows.microsoft.com/sr-latn-cs/windows-live/movie-maker-file-types-faq?wlexpid=B86120B9D97F42AD960A0E9FA916BCD6
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Video datoteke 

Tipovi (formati) video datoteka Oznake tipa datoteke 

Datoteke formata „Windows Media Video“ 

(WMV datoteke) 

.wmv 

Windows Media datoteke .asf i .wm 

AVCHD datoteke .m2ts, .mts i .m2t 

Apple QuickTime datoteke .mov i .qt 

DV-AVI datoteke .avi 

Datoteke formata „Microsoft snimljeni TV 

program“ 

.dvr-ms i .wtv 

MPEG-4 video datoteke .mp4, .mov, .m4v, .3gp, .3g2 i .k3g 

MPEG-2 video datoteke .mpeg, .mpg, .mpe, .m1v, .mp2, .mpv2, .mod, 

.vob i .m2t 

MPEG-1 video datoteke .m1v 

Motion JPEG datoteke .avi i .mov 

 

Grafičke datoteke 

Tipovi (formati) grafičkih datoteka Oznake tipa datoteke 

Datoteke formata „Joint Photographic Experts 

Group“ (JPEG datoteke) 

.jpg, .jpeg, .jfif i .jpe 

Datoteke formata „Tagged Image File Format“ 

(TIFF datoteke) 

.tif i .tiff 

Datoteke formata „Graphics Interchange Format“ 

(GIF datoteke) 

.gif 

Windows Bitmap datoteke .bmp, .dib i .rle 

Datoteke ikona .ico i .icon 

Datoteke formata „Portable Network Graphics“ 

(PNG datoteke) 

.png 

Datoteke formata „HD Photo“ .wdp 

 

http://windows.microsoft.com/sr-latn-cs/windows-live/movie-maker-file-types-faq?wlexpid=B86120B9D97F42AD960A0E9FA916BCD6
http://windows.microsoft.com/sr-latn-cs/windows-live/movie-maker-file-types-faq?wlexpid=B86120B9D97F42AD960A0E9FA916BCD6
http://windows.microsoft.com/sr-latn-cs/windows-live/movie-maker-file-types-faq?wlexpid=B86120B9D97F42AD960A0E9FA916BCD6
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Audio datoteke 

Tipovi (formati) audio datoteka Oznake tipa datoteke 

Datoteke formata „Windows Media Audio“ 

(WMA datoteke) 

.asf, .wm i .wma 

Datoteke formata „Pulse-code Modulation“ (PCM 

datoteke) 

.aif, .aiff i .wav 

Datoteke formata „Advanced Audio Coding“ (AAC 

datoteke) 

.m4a 

MP3 datoteke .mp3 

Sve video datoteke podržane u programu Movie 

Maker 

 

 

4.3 Određivanje redosleda aktivnosti u procesu kreiranju filma 

 

U kreiranju jednog filma važni su koraci i redosled radnji koje ćemo preduzeti. Zato, pri režiranju bilo 

kog filma krećemo od scenarija i prema njemu kreiramo potrebne video i audio materijale, 
montiramo materijale i na kraju ih publikujemo u vidu filma Potrebni koraci u izradi filma se mogu 
definisati na sledeći način: 

 definisanje teme kojom će se naš film baviti i pisanje scenarija u kome ćemo tačno odrediti 
koje audio i video materijale treba da kreiramo, u kom programu ćemo raditi na filmu i na 
kraju, kako ćemo film koristiti i u koje svrhe ga objavljivati; 

 kreiranje potrebnih materijala: fotografija, video snimaka, muzičkih zapisa koje ćemo koristiti 
u filmu; 

 kreiranje novog projekta u programu Movie Maker; 

 preuzimanje materijala u vidu fotografija ili video snimaka sa eksternog uređaja (veb kamera, 
fotoaparat) ili sa računara; 

 snimanje ili preuzimanje narativne priče (muzičke pratnje) u vidu muzičkog zapisa; 

 aranžiranje svih audio i video materijala; 

 čuvanje konačnog filma u formatu određenom prema potrebi; 

 publikovanje filma: postavljanje filma na internet strani koja je tome namenjena, prezentacija 
filma učenicima u učionici ili objavljivanje filma na neki drugi način. 

 

Kada biramo temu za naš film moramo voditi računa o tome da je sama tema dovoljno inspirativna i 
da nam pruža mogućnost da objedinimo znanje koje smo stekli u radu sa audio i video materijalima, 
kao i poznavanje savremenih trendova u svetu i kod nas.  

 

http://windows.microsoft.com/sr-latn-cs/windows-live/movie-maker-file-types-faq?wlexpid=B86120B9D97F42AD960A0E9FA916BCD6
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4.4 Biranje teme filma 

 

Korisnik programa Movie Maker mora da posveti podjednaku pažnju kako tehničkom delu svoga 
filma tako i  estetskoj vrednosti koju želi da pokaže i poruci koju filmom želi da pruži.  

Jedan od najvećih izazova svih početnika u radu sa multimedijom je kreiranje filmova o prirodi ili 
običajima svog kraja. Razlozi za to su obilje fotogafija i video materijala koje možemo da napravimo 
na tu temu kao i posebnost takvih filmova u pogledu različitosti krajeva i kultura o kojima govore.  

Takođe, ako vam je cij da svoj film postavite na neku od internet strana, postoji uvek više nivoa 
zastupljenosti na Internetu kao globalnoj mreži, za koje bi takav sadržaj mogao da bude namenjen. 
Film u kome ćete opisati svoj grad, jedno godišnje doba i neke druge specifičnosti je odličan materijal 
za lokalni sajt vašeg grada, ali takođe i za sve sajtove na državnom i svetskom nivou, koji se bave 
popularizacijom različitih kultura, turizma i na kraju očuvanja kulturne baštine.  

Ako ste odabrali godišnje doba ili praznik za koji mislite da vašem kraju daje najviše mogućnosti da se 
predstavi u najlepšem svetlu sa svim svojim osobenostima i kultorološkim karakteristikama, 
definišite temu i krenite sa radom. Predlažemo da tema za kreiranje filma bude Zima i novogodišnji 
praznici u mom kraju.  

 

4.5 Snimanje fotografija, video i audio materijala 

 

Potreban materijal za kreiranje filma bi mogao da sadrži: 

 početni video snimak na kome ćete predstaviti sebe; 

 nekoliko fotografija divnih zimskih pejzaža kraja u kome živite; 

 film o kićenju jelke ili o svečanom izgledu vašeg okićenog grada; 

 kao muzičku pozadinu, neku od bezbroj melodija koje govore o Novoj godini i božićnim 
praznicima; 

 nekoliko slika vezanih za božićne praznike i običaje; 

 priču kojom ćete na najbolji način predstaviti sav materijal od koga ste napravili film i što je 
najvažnije saopštiti poruku koju želite da vaš film nosi. 

Materijal koji je potreban za kreiranje jedne lepe zimske priče, predstavlja dobru osnovu za početak. 
Kao i u bilo kom drugom kreiranju umetničkog sadržaja ovo sve ne mora da bude konačan spisak 
potrebnog materijala. Sve ono što, u skladu sa objašnjenim koracima, niste predvideli možete u bilo 
kom trenutku kreiranja filma naknadno dodati. Čak i onda kada film eksportujete u bilo kom formatu 
podržanom u programu Movie Maker, uvek se možete vratiti na sačuvani projekat i editovati kreirani 
film. 

 

Kreiranje fotografija i video snimaka 

Kao prvi zadatak koji se očigledno nameće je prikupljanje potrebnih fotografija i video snimaka. Za 
snimanje kvalitetnih fotografija i video snimaka možete koristiti digitalni fotoaparat, digitalnu ili veb 
kameru ili mobilni telefon. 

http://windows.microsoft.com/en-us/windows-live/movie-maker
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Da bi smo napravili dobru fotografiju i jasan film moramo voditi računa o položaju svetla. Svetlost 
različito utiče na fotografiju. Postoje četiri slučaja kako svetlo može da pada na objekat 
fotografisanja: sa strane, sa leđa, sa prednje strane i odozgo. Kada svetlo dolazi sa strane, a to je 
slučaj u jutarnjim i popodnevnim satima, na fotografiji će se stvoriti veoma zanimljive senke i biće 
istaknuti detalji. Kada svetlo dolazi sa leđa ono vrlo lako može da “prevari” fotoaparat da smanji 
ekspoziciju i time zatamni sliku. To je zato što je prednji deo objekta slikanja u senci. U tom slučaju 
povećavamo ekspoziciju ili koristimo blic. Ukoliko, pak, svetlo pada sa prednje strane, iz pravca 
fotoaparata, na slici će se pojaviti male senke, a detalji na slici neće se videti dobro. Ovaj slučaj je 
dobar za slikanje jer ne moramo dodatno da podešavamo fotoaparat. Jutarnje i večernje sunce daju 
odlično osvetljenje, ali možemo imati probleme pri snimanju u podne, jer svelost pada odozgo na 
predmet koji snimamo. Tada se na fotografiji mogu pojaviti objekti koji su previše osvetljeni. Ukoliko 
se slika osoba, onda joj se gornji deo nosa jako osvetli i oko očiju joj se javljaju senke.  

Pored smera svetlosti moramo voditi računa i o tome da li je svetlo direktno ili difuzno (raspršeno). 
Direktno svetlo dolazi samo iz jednog jakog izvora kao što je, na primer, sunce. Tada na fotografiji 
dobijamo jake kontraste između objekata koji su osvetljeni i onih koji su u senci. Kod difuznog svetla 
objekat koji se slika je osvetljen iz više pravaca. Kada je maglovit ili oblačan dan sunce proizvodi 
difuzno svetlo. Objekti koji su na slici napred, tada su bolje osvetljeni i jasnije se vide, dok se oni u 
pozadini slabije vide. Difuzno svetlo možemo dobiti i pomoću veštačkog svetla.  

Kada želimo da fotografišemo sitne objekte, takve fotografije se zovu makro fotografije. Pozadina 
objekta u tom slučaju mora da bude što kontrastnija u odnosu na objekat koji se snima, kao papir sa 
neutralno sivom bojom sa malo jačim sivim prugama.  

 

Dobro je obratiti pažnju na neka osnovna pravila pri snimanju i izradi filmova:  

 Pre snimanja dobro je napraviti scenario i po njemu pripremiti scene. Prilikom 
snimanja dobro je napraviti više video sekvenci iz više uglova i naknadno ih iseći i složiti u 
celinu, te dobro izmontirati, pri čemu je poželjno imati više video materijala nego što je 
planirana dužina samog filma; 

 Svetlost ne sme da pada direktno na objektiv kamere. Za snimanje je dobro koristiti 
rane jutarnje ili kasne popodnevne sate. Ako se snimanje izvodi po jakom suncu treba 
pomeriti kameru u senku ili napraviti sopstvenu senku (pomoću kišobrana na primer), 
promeniti perspektivu snimanja ili osvetliti objekat snimanja reflektorom (ili koristiti filtere). 
Pozadina za snimanje ne sme da bude dominantna jer odvlači pažnju prilikom gledanja. Pri 
snimanju providnih objekata potrebno je da se odabere pogodna pozadina. Pozadina bi 
trebalo da je tamnija i rebrasta. Svetlost kod snimanja providnih objekata treba da pada sa 
bočne strane objekta snimanja ili da se izvor svetlosti nalazi iza objekta snimanja. 

 Pri snimanju, kretanje kamera i zumiranje treba da budu spori i nežni, bez brzih i 
naglih pomeranja. Da prilikom snimanja ruka ne bi podrhatavla, dobro je koristiti stativ. 
Poželjno je približiti se što više objektu snimanja, a softverski zum upotrebljavati samo kada 
fizičko približavanje nije moguće. Primena klasičnih pravila fotografije kao što su pravilo 
trećine, balansa, uokviravanja i rasporeda linija koje vuku pogled, može doprineti vizuelnoj 
atraktivnosti snimljenog video materijala. Na video snimku je dodatno važna dinamika scena i 
događaja. Za snimanje arhitektonskih i muzejskih objekata u obrazovne svrhe promena scena 
treba da bude spora, dok za prezentovanje realnih situacija treba da bude slična kao realnom 
životu. 
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 Dobro je odvojeno snimiti i nasnimiti zvuk pri montiranju filma, da se ne bi čulo 
disanje kamermana ili zveckanje njegove opreme. Tada se i dinamika zvukova koji se dodaju 
naknadno može određivati u toku montaže filma. Sam zvuk se može snimiti na drugačijem 
udaljenju nego što je snimljen video, što omogućava da se istakne neki govornik, pravilno 
snimi dijalog gde se oba govornika jednako dobro čuju, smanji pozadinski šum ili da se iseku 
neki slučajni zvuci  i dr.  Odvojeno snimnjen zvuk je moguće i obraditi pre ubacivanja u film.  

 Posle snimanja video i audio materijala, na red dolazi montaža filmova, koja se odvija 
po planu koji je napravljen na osnovu scenarija, ali može da bude modifikovan u toku 
montaže ako se za to ukaže potreba. Pri montaži se mogu ubrzati ili usporiti događaji 
(multipliciranjem svakog frejma (kadra) se usporava kretanje, a ubrzanje postiže sečenjem 
nekih frejmova, ili montiranjem izvučenih po događaj ključnih frejmova). Redosled događaja i 
scena, dinamika scena i trenuci reza su jako važni za doživljaj o filmu. Dodavanje naracije, 
zvuka ili muzike je obavezno. Opciono je dodavanje titla i prelaznih efekata. 

Ako je program Movie Maker instaliran na operativnom sistemu Windows 7 i imate veb kameru 
povezanu i instaliranu na vašem računaru, možete odmah praviti video snimak uživo. Veb-kamere su 
uglavnom povezane sa računarom preko USB konekcije, dok noviji laptopovi, gotovo svi, imaju već 
ugrađenu veb-kameru. 

 

Kreiranje audio zapisa 

Audio zapise u vidu muzičkog zapisa možete napraviti i editovati u programu Audacity. Ukoliko želite 

da muzičku podlogu za svoj film koristite audio zapis koji već postoji na internetu možete ga pronaći 

pretragom na najpoznatijem kanalu za objavljivanje audio i video zapisa www.youtube.com. 

Snimanje glasa (narativne priče) obezbeđuje sam program Movie Maker i u njemu možete uraditi i 

konačno aranžiranje i kombinovanje svih fotografija, audio i video materijala. 

 

4.6. Uvoz fotografija i video materijala sa eksternog uređaja 

 

Kada ste sigurni da ste prikupili sav potreban material za početak kreiranja filma pomoću programa 
Movie Maker, potrebno je da uvezete fotografije, audio i video zapise sa uređaja na kome se sav taj 
materijal nalazi. 

Zavisno na koji način ste snimili fotografije i video snimke, eksterni uređaji sa kojih možete preuzeti 
fotografije i video zapise su: 

 Digitalna kamera 

 Digitalni fotoaparat 

 Fleš memorije, kao što je Secure Digital (SD) ili CompactFlash memorijska kartica 

 CD ili DVD medijumi 

 Video traka koja je u digitalnoj video kameri (DV) ili High-Definition Video (HDV) cameri i 

 Mobilni telefon koji je povezan sa vašim kompjuterom i 

http://windows.microsoft.com/en-us/windows-live/movie-maker
Formulari/www.youtube.com
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Da biste uvezli fotografije i video zapise sa fotoaparata u Movie Maker, povežite fotoaparat sa 
računarom putem USB kabla, a zatim uključite fotoaparat. Kliknite na ikonicu za padajući meni u 

krajnjem levom uglu , a zatim izaberite opciju Import from device (Slika 4). Ukoliko se pojavi 
poruka Photos and videos will be imported into Photo Gallery, kliknite na dugme OK (Slika 5). 

 

 

Kliknite na uređaj iz koga želite da uvezete fotografije, audio i video zapise, a zatim kliknite na dugme 
Import. Otvara se još jedan dijaloški prozor u kome birate koje ćete fotografije, audio i video zapise 
sa fotoaparata preuzeti (importovati) (Slika 6). 

 

 

 

 

 

Slika 6 

U zavisnosti koju ste opciju odabrali Movie Maker daje prikaz odabranih fotografija i video zapisa i 

na kraju daje dijaloški prozor u kome birate da koristite Photo Gallery za rad sa predloženim 

tipovima fotografija.  

 

 

 

 

 
Slika 7 Slika 8 

Slika 4 

Slika 5 
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Radni prozor Photo Gallery pokazuje u levom delu da je u direktorijumu Pictures formiran drugi 

direktorijum sa odabranim fotografijama na osnovu informacija o fotografijama. Držeći pritisnut 

taster SHIFT, klikom na prvu i poslednju fotografiju, selektujete sve fotografije (Slika 9). Da biste 

konačno preuzeli sve fotografije i video zapise u program Movie Maker potrebno je da na kartici 

Create kliknete na opciju Movie (Slika 10). 

 

Slika 9 

 

 

Slika 10 

 

4.7. Uvoz fotografija i video materijala sa računara 

 

Ako vam se fotografije i video zapisi nalaze na računaru, u odbranom direktorijumu u radnom 

prozoru programa Movie Maker, na kartici Home kliknite na opciju Add videos and photos i u 

dijaloškom prozoru selektujte sve fotografije koje želite da uvezete, pa kliknite na dugme Open (Slika 

11).  
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Slika 11 

Bez obzira na koji ste način importovali fotografije i video zapise (sa fotoaparata, veb kamere ili 
računara), rezultat koji sada vidite u programu Movie Maker  je isti. U centralnom delu radnog 
prozora fotografije će biti poređane onim redom kako ste ih uvezli, a u levom delu radnog prozora 

videćete da je film od fotografija već “napravljen” i da ga klikom na taster play  možete 
pregledati. Primetićete da je Movie Maker poređao slike kao i video zapis podeljen na frejmove na 
osnovu njihovih naziva. Naravno, u toku rada na svom filmu možete menjati ovaj raspored onako 
kako želite da vaš film izgleda (Slika 12). 

 

Slika 12 
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Ukoliko se kod nekih fotografija pojavljuju infomacije koje želite da uklonite u obliku teksta ispod 

slike, kliknite desni klik mišem na taj tekst i u ponuđenom meniju birajte opciju Remove (Slika 13). 

 

Slika 13 

4.8 Čuvanje projekta na računaru 

Pomenuli smo već da ovako uveženi materijali u početnim koracima ne predstavljaju i konačan izbor 

materijala. Nezavisno od toga da li ćete u daljim koracima menjati ili dodavati novi sadržaj pravo je 

vreme da sačuvate projekat na svom računaru. 

Ako želite da sačuvate svoj projekat, kliknite na ikonicu za padajući meni u krajnjem levom uglu 

 i u ponuđenim opcijama odaberite Save project (Slika 14). Podrazumevano (po default-u) 

Movie Maker čuva projekat u direktorijumu My documents i dodeljuje mu ime My movie. Naravno, 

korisnik programa bira direktorijum u kome će čuvati svoj projekat i dodeljuje mu željeni naziv (Slika 

15). 

 
Slika 14 

Slika 15 
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4.9 Otvaranje započetog projekta 

Za otvaranje započetog projekta koji smo sačuvali pod podrazumevanim imenom My movie u 
radnom prozoru programa Movie Maker kliknite na ikonicu za padajući meni u krajnjem levom uglu 

 i u ponuđenim opcijama odaberite Open project (Slika 16). U delu desno od ove opcije nalazi 
se spisak ponuđenih projekta Recent Projects, kliknite na projekat My movie i u radnom prozoru će 
se otvoriti ceo projekat (Slika 17). 
 

 

Slika 16 

 

 

Slika 17 

Ono što možemo videti u levom delu radnog prozora je ceo film kao i njegovo ukupno trajanje (Slika 
18).  
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Na plejeru ispod nalaze se: dugme Play , dugme za brzi odlazak na kraj filma , a  kada 

pokrenemo film dugme za zaustavljanje filma  i dugme za brzi odlazak na početak filma  
(Slika 19). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Slika 18 

 

 

 

Slika 19 

4.10 Osnovno podešavanje fotografija i video zapisa 

Kada pređete mišem preko bilo koje slike u radnom prozoru programa Movie Maker u kome je 

otvoren vaš projekat My movie, pojaviće se prozorčić sa informacijama (Slika 18):  

 naziv slike i format slike,  

 vreme u sekundama koliko traje slika u filmu (Duration),  

 tranzicija koja se po pravilu ne dodeljuje pri automatskom pravljenju filma ali je korisnik 
kasnije može dodati (Transition);  

 efekat pomeranja i zumiranja slike (Pan and zoom), koji se može primeniti na sve slike u 
projektu; 

 efekti koji su primenjeni na slici (Effects). 
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Slika 20 

Kada pređete mišem preko frejma video snimka, pojaviće se prozorčić sa informacijama (Slika 21): 

 naziv video snimka i njegov format,  

 vreme koliko traje video zapis (Duration),  

 tranzicija koja se po pravilu ne dodeljuje pri automatskom pravljenju filma ali je korisnik 
kasnije može dodati (Transition);  

 efekat pomeranja i zumiranja celog video snimka (Pan and zoom), koji se može primeniti na 
sav materijal u projektu; 

 efekti koji su primenjeni na video snimku (Effects); 

 brzina filma. 
 

 

Slika 21 

Primetićete da je Movie Maker dodelio svakoj od importovanih slika vreme trajanja 7 sekundi. 
Trajanje možete promeniti tako što selektujete određenu fotografiju, pa zatim na kartici Video Tools, 
u grupi Edit kliknete na numeričko polje Duration gde birate trajanje od 7 do 30 sekundi (Slika 22). 
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Slika 22 

4.11 Dodavanje efekata fotografijama 

Svakoj od korišćenih fotografija možete dodavati neke efekte. Potrebno je da selektujete fotografiju i 
efekat možete postići na nekoliko načina. 

 

Animacije (Animations) 

Na kartici Video Tools, u grupi Animations možete da podesite prelaz (Transitions) između 
fotografija u filmu, kao i pomeranje i zumiranje (Pan and zoom) svake od fotografija zasebno. Za obe 
vrste efekata postoji opcija da se efekat može primeniti na sve fotografije u filmu (Apply to all) 
 (Slika 23). 

 

Slika 23 

 

Vizualni efekti (Visual Effects) 

Na kartici Video Tools, u grupi Visual Effects možete da podesite efekte (Effects) za svaku fotografiju 
zasebno, kao i osvetljenost (Brightness). Postoji opcija da se efekat može primeniti na sve fotografije 
u filmu (Apply to all) (Slika 24). 

 

Slika 24 

4.12 Osnovna podešavanja importovanog video zapisa 

Posle podešavanja vremena pojavljivanja slika potrebno je da, na osnovu teme koju ste odabrali, 
editujete video zapis koji ste importovali zajedno sa fotografijama. U programu Movie Maker 
možete da importovani video zapis skratite, tako da se u konačnom filmu pojavi samo željeni deo. 
Izaberite video zapis koji želite da skratite i postupite na jedan od sledećih načina: 
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 Da biste postavili novu početnu tačku, kliknite mišem ispred frejma za koji želite da bude 
početak video zapisa.  

 U kartici Video Tools, u grupi Edit kliknite na dugme Set start point . 
 Da biste postavili novu krajnju tačku, kliknite mišem iza frejma za koji želite da bude 

završetak video klipa 

 U kartici Video Tools, u grupi Edit kliknite na dugme Set end point . 
 

Film sada sadrži samo željeni deo importovanog video zapisa (Slika 25). 

 

Slika 25 

Da biste preciznije skratili video snimak možete koristite i opciju Trim. Kada na kartici Video Tools, u 
grupi Edit kliknite na opciju Trim, otvara se dijaloški prozor u kome Start point i End point postavljate 
tačno u sekundama (Slika 26). 

 

Slika 26 

 

Na kartici Video Tools, u grupi Edit  možete da promenite brzinu video zapisa, a kao podrazumevana 
vrednost je postavljena 1x, koju ne treba menjati jer jedino tako možete videti svaki frejm video 
zapisa i editovati ga kako vama odgovara (Slika 27). 

 

 

Slika 27 
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Na kartici Video Tools, u grupi Edit  možete da promenite jačinu zvuka u video zapisu klikom na 
opciju Video volume. Ova opcija je veoma korisna zavisno od toga da li ćete kao muzičku pozadinu 
odabrati neki drugi muzičkizapis, da li ćete snimiti narativnu priču autora. Ponavljamo još jednom 
činjenicu da je u programu Movie Maker uvek omogućeno da u toku samog rada, dodajete nove 
fotografije, video snimke i muzičku pozadinu sve do konačnog kreiranja filma. Kada kliknete na opciju 
Video volume pojavljuje se klizač, koji možete pomerati i time birati jačinu zvuka uveženog 
(importovanog) video zapisa (Slika 28). 

 

 

Slika 28 

Na kartici Video Tools, u grupi Edit  možete da promenite jačinu zvuka na početku video zapisa i na 
kraju video zapisa, tj. da se na početku i na kraju zapisa zvuk postepeno ili brzo pojačava. Ovo se 
postiže opcijoma Fade in (na početku video zapisa) i Fade out (na kraju video zapisa) (Slika 29). 

 

Slika 29 

 

4.13 Menjanje redosleda fotografija i video zapisa na vremenskoj liniji 

Promena redosleda fotografija i video zapisa se može raditi na vremenskoj liniji Timeline. 
Prebacivanje fotografija se postiže najjednostavnijim prevlačenjem tako što fotografiju selektujete 
klikom miša i onda, držeći levi taster pritisnut, povučete fotografiju do željenog mesta na vremenskoj 
liniji i tako sa svakom fotografijem do željenog redosleda (Slika 30). 
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Slika 30 

4.14 Dodavanje početnog kadra sa naslovom 

Movie Maker  omogućava da na početku filma postavite kadar sa naslovom. Na kartici Home kliknite 

na opciju Title (Slika 31).  

 

Slika 31 

Dodaje se na početku filma kadar i otvara se kartica Text tools sa podešavanjima: 

 vrsta, boja i veličina fonta teksta naslova i transparentnost teksta; 

 

 opcija za editovanje teksta, boja pozadine samog kadra, vreme kada se naslov pojavljuje od 
početka filma i koliko traje pojavljivanje naslova; 

 

 efekti pojavljivanja teksta naslova 
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4.15 Dodavanje teksta fotografiji i poslednjih kadrova filma 

Na kartici Home pored opcije Title postoje i opcije Caption i Credits. Ako na vremenskoj liniji kliknete 
isped bilo koje fotografije pa na kartici Home kliknete na opciju Caption toj fotografiji možete dodati 
bilo koji tekst sa prethodno opisanim podešavanjima. Kada kliknete na opciju Credits na kartici 
Home,  bez obzira gde se nalazite na vremenskoj liniji, Movie Maker sam dodaje neke od kadrova na 
kraju filma zavisno od opcija koje ste izabrali u padajućoj listi (Slika 32). Podešavanja teksta su ista jer 
se otvara kartica Text tools. 

 

Slika 32 

4.16 Dodavanje početnog video snimka sa veb kamere 

Analizirajući temu filma, uveženi materijal je sad u redosledu koji odgovara, a potreban nam je jedan 
video snimak u kome ćemo predstaviti sebe i našu temu na samom početku posle kadra sa 
naslovom. Već smo pomenuli da u programu Movie Maker  takav snimak možemo uraditi pomoću 
veb kamere koja je povezana na naš računar ili se, ako se radi o laptopu, već nalazi na njemu. 

Da biste uvezli odnosno napravili direktan snimak sa veb kamere potrebno je da prvo kliknete na kraj 
kadra sa naslovom, pa na kartici Home kliknete na opciju Web cam video i u levom gornjem uglu 
radnog prozora pojaviće se tasteri za početak (Record) i kraj (Stop) snimanja video zapisa (Slika 30). 

 

Slika 33 
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U trenutku kada pritisnete taster za kraj snimanja Stop pojavljuje se dijaloški prozor za snimanje 
video snimka koji ste napravili. Movie Maker podrazumevano čuva video snimak kao Windows 
Media Video File u direktorijumu My pictures i dodeljuje mu ime prema datumu i vremenu kada je 
zapis nastao. Naravno, korisnik programa sam bira direktorijum u kome će čuvati video zapis i 
dodeljuje mu željeni naziv (Slika 34). 

 

Slika 34 

Movie Maker vas vraća na radni prozor gde ćete na vremenskoj liniji videti da je vaš tek snimljeni 

video zapis dodat. Ukoliko se video zapis ne nalazi na željenom mestu, prevlačenjem, koje je ranije 

opisano, napravite željeni raspored fotografija i video zapisa. 

4.17 Dodavanje muzičke pozadine 

Ukoliko želimo da kao muzičku pozadinu našeg filma imamo određenu melodiju, onda je potrebno 
jačinu zvuka importovanog video zapisa na sredini vremenske linije postaviti na Mute. Kao što je već 
ranije opisano kliknite na početak tog video zapisa i na kartici Video Tools, u grupi Edit  kliknete na 
opciju Video volume gde se pojavljuje klizač na kome podesite nultu jačinu zvuka. 

Ako želite da dodate svoju priču kao zvučnu pozadinu, na kartici Home kliknite na opciju Record 
narration, gde u padajućem meniju birate jednu od dve opcije Record naration ili Add sound (Slika 
35). 

 

 

 

 

 

 

 

 

Slika 35 
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Ukoliko ste odabrali Record narration, u levom gornjem uglu radnog prozora pojaviće vam se tasteri 
početak (Record) i kraj (Stop) snimanja vaše prateće priče. Imajte u vidu prilikom snimanja, ukoliko 

želite da vaša priča ide tokom celog filma, dovoljno je da na vremenskoj liniji pratite snimanje 
naracije i kliknete na Stop kada kursor dođe do kraja poslednjeg frejma filma. Naravno, potrebno je 
da mikrofon bude priključen na odgovarajući audio jack. 

Onog trenutka kada kliknete na Stop dugme otvara se dijaloški prozor u kome birate gde ćete 
sačuvati Windows Media Audio File, tj. prateću priču koju ste snimili na ovaj način. Podrazumevano 
Movie Maker čuva projekat u direktorijumu My music i dodeljuje mu ime prema datumu i vremenu 
kada je zvučni zapis nastao. Naravno, korisnik programa bira direktorijum u kome će čuvati zvučni 
zapis i dodeljuje mu željeni naziv. 

Kada kliknte na dugme Save, Movie Maker vas vraća na radni prozor gde možete videti da je dodati 

zvuk predstavljen kao braon obojena traka ispod fotografija i video zapisa od kojih je film napravljen 
(Slika 36). 

 

Slika 36 
 

Ako želite da dodate i neku muzičku pozadinu koja će pratiti narativnu priču na kartici Home kliknite 
na opciju Add music (Slika 37). 

 

Slika 37 

Otvara se dijaloški prozor u kome birate željeni audio zapis sa određene lokacije u računaru. Kada 
kliknete na dugme Open, Movie Maker vas vraća na radni prozor gde možete videti da je dodati zvuk 
predstavljen kao zelena obojena traka ispod fotografija i video zapisa od kojih je film napravljen, a 
iznad trake koja predstavlja prateću priču (Slika 38). 
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Slika 38 

Sa dodatom muzičkom pozadinom pojavljuje se kartica Music tools, opcije u okviru ove kartice su 
iste kao i kod kartice Narration tools. Možete podešavati jačinu zvuka tako da se muzička pozadina 
čuje tiše ili glasnije u odnosu na priču (Music volume i Narration volume). Takođe, opcijama Fade in i 
Fade out podešavate početak i kraj muzičke pozadine i priče. U grupi Editing podešavate tačno 
vreme početka i kraja muzičke pozadine i priče (Slika 39). 

 

Slika 39 

Ako želite da uklonite muzičku pozadinu ili narativnu priču, kliknite levim tasterom miša na traku koja 
predstavlja muziku ili priču, pa u padajućem meniju odaberite opciju Remove (Slika 40).  

 

Slika 40 
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4.18 Snimanje filma  

Ako ste zadovoljni svim podešavanjima koja ste uradili na importovanim fotografijama i video 
zapisima u filmu, dodatom muzičkom pozadinom i pratećom pričom, vreme je da sačuvate film u 
nekom pogodnom formatu. 

U radnom prozoru programa Movie Maker kliknite na ikonicu za padajući meni u krajnjem levom 

uglu  i u odaberite Save movie. Otvara se niz ponuđenih opcija koje omogućavaju korisniku da 
film sačuva u različitim formatima, zavisno od potreba zbog kojih se film i kreira. Za prvo kreiranje 
filma odaberite opciju Recommended for this project, gde će se i otvoriti prozorčić sa osnovnim 
informacijama o rezoluciji i veličini filma (Slika 41). 

 

Slika 41 

U dijaloškom prozoru program Movie Maker  podrazumevano čuva film u direktorjumu My pictures 
pod imenom pod kojim je sačuvan i projekat, u ovom slučaju My movie. Odaberite naziv filma u 
skladu sa temom koju ste odabrali na početku. Format u kome se čuva film je MPEG4 (Slika 42). 

 

Slika 42 
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Kada kliknete na dugme Save, program Movie Maker  vraća korisnika na radni prozor u kome otvara 
prozor sa progres barom koji pokazuje tempo čuvanja filma (Slika 43). Sa završenim čuvanjem filma 
Movie Maker  nudi prozor sa pitanjem da li korisnik želi da odmah vidi film u plejeru (Slika 44). Da 
biste uočili koliko je važno u kom formatu ekportujete film vratite se na direktorijum My pictures, 
kliknite desnim klikom na ikonicu koja predstavlja vaš film i odaberite opciju Properties i možete 
videti veličinu kreiranog filma (Slika 45) 

 

Slika 43 

 

Slika 44 

 

Slika 45 
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4.19 Otvaranje snimljenog filma i projekta u programu Movie Maker 

 

Zatvorite program Movie Maker, pronađite film koji ste snimili u odabranom direkorijumu, kliknite 
desnim klikom na ikonicu koja predstavlja film i u padajućoj listi odaberite Open with Movie Maker. 
Primetićete da sada fotografije i video zapis nisu tako pregledno odvojeni jer predstavljaju jedan 
video zapis (Slika 46).  

 

Slika 46 

Ipak, snimljeni film i dalje možete editovati. Ukoliko želite da podelite film na sekvence, to ćete 
postići korišćenjem alatke Split. Na vremenskoj liniji (Timeline) vašeg filma kliknite na tačku od koje 
želite da počinje jedan deo filma, pa na kartici Video Tools, u grupi Edit  kliknite na opciju Split. Na 
ovaj način ste jedan film podelili na dva, pri čemu prevlačenjem (Move) možete menjati redosled ova 
dva filma ili ukloniti jedan od njih (Remove) (Slika 47). 

 

 

Slika 47 

4.20 Ponovo otvaranje projekta u kome je urađen film  

Snimanjem filma niste ipak izgubili informacije o bilo kojoj fotografiji ili video zapisu koji je sada deo 
vašeg filma. Kada u radnom prozoru programa Movie Maker kliknite na ikonicu za padajući meni u 

krajnjem levom uglu .  
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U ponuđenim opcijama odaberete Open project, otvorite projekat u kome je urađen snimljeni film, u 
ovom slučaju My movie, dobijate sve fotografije i video zapise na vremenskoj liniji, koje i dalje 
možete da editujete (Slika 48). 

 

Slika 48 

4.21 Objavljivanje filma (Publish)  

Program Movie Maker omogućava da direktno objavite film na nekoj od društvenih mreža i video 

kanala. Potrebno je da kliknete na ikonicu za padajući meni u krajnjem levom uglu , u 
ponuđenim opcijama odaberete opciju Publish movie, gde vam se otvara padajuća lista sa 
nabrojanim društvenim mrežama (Facebook, Flickr) i kanalima specijalizovanim za objavljivanje 
dokumenta (Skydrive) ili filmova i video zapisa (YouTube, Vimeo) (Slika 49). 

 

Slika 49 
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Bez obzira koju opciju birate u prvom dijaloškom prozoru birate rezoluciju filma od kojih vam je 
jedna opcija preporučena i ona predstavlja neku sredinu između krajnje veličine datoteke (od koje 
zavisi i brzina otpremanja (upload-a) na internet kanal koji ste izabrali) i rezolucije filma (od koje 
zavisi kvalitet filma) (Slika 50). 

 

Slika 50 

Da biste otpremili film na bilo koji od pogodnih internet kanala za objavljivanje filmova i video zapisa 
(YouTube, Facebook), program Movie Maker nudi dijalog da se projavite sa svojim Microsoft 
nalogom (Slika 51). 

 

Slika 51 

Postoji više koraka koji vas vode kroz postupak otpremanja. Ukoliko imate naloge na ovim kanalima, 
prijavljujete se parametrima tih naloga. 
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4.22 Otpremanje filma na YouTube 

 

Ako želite da otpremite film na svoj YouTube kanal, posle prvog logovanja sa Microsoft nalogom, 
dobijate dijaloški prozor da unesete parametre za svoj YouTube kanal (Slika 52). 

Pored ikonice Sign in u krajnjem desnom uglu radnog prozora programa Movie Maker , pojavljuje se 
ime pod kojim ste prijavljeni u okviru Microsoft naloga (Slika 53). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Kada se prijavite sa svojim youtube nalogom, otvara se dijaloški prozor u kome upisujete i birate 
neke od inforamcija o vašem filmu: naslov filma, opis filma, povezane reči po kojima će se film 
pretraživati na YouTube kanalu, kategoriju kojoj film pripada i ko film može da vidi na internet mreži 
(Public ili Private). Na kraju kliknete na dugme Publish, koje će biti aktivno tek kada sva polja budu 
popunjena i izabrana (Slika 54). 

Slika 52 

Slika 53 
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Slika 54 

U radnom prozoru se pojavljuje prozorčić sa progresom koji pokazuje tempo učitavanja filma na 
kanal YouTube (Slika 55). 

 

Slika 55 

Nakon otpremanja filma pojavljuje se i prozor sa pitanjem da li korisnik želi da odmah vidi film (Slika 
56). 

 

Slika 56 

Kada kliknete na dugme Watch online otvara se YouTube kanal sa filmom. 
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5. Objavljivanje video sadržaja na YouTube kanalu 

5.1 Fenomen YouTube kanala 

 YouTube je fenomen koji privlači milijarde gledalaca kao i korisnika, koji svakodnevno postavljaju 
muzičke spotove, crtane filmove, ali i slike i video snimke iz privatnog života.  

YouTube, koji je osnovan februara 2005, omogućava 
milijaradama ljudi da ga gledaju i dele originalne video 
snimke. YouTube, takođe, nudi forum na kojem se ljudi mogu 
povezivati, informisati  i na taj način predstavlja, do sada, 
najveću platformu za distribuciju autorima sadržaja kao i 
velikim i malim oglašavačima. Yakov Lapitsky, jedan od prvih 
vlasnika YouTube-a je postavio kratki privatni film “Me at the 
zoo”, snimljen u Zoo vrtu u San Diegu, na server 23. Aprila 
2005 i to je prvi video klip postavljen na YouTube. 

YouTube je danas postao najmoćije sredstvo oglašavanja, sredstvo masovne komunikacije i 
uključivanjem „običnih ljudi“, korisnika interneta, u kreiranje medijskih sadržaja dao je internetu 
jednu potpuno novu dimenziju. Društvene mreže i kanali kao što je YouTube su dale mogućnost da 
bilo koji korisnik objavljuje tekstualni, audio i video materijal, koji može da pogleda i pri tome oceni 
ili prokomentariše veliki broj ljudi. Izvori sa društvenih mreža u velikom broju slučajeva su primarni 
izvori informacija tj. akteri ili svedoci događaja. Međutim, veliki broj podataka i informacija na vebu 
se ne mogu uzeti kao verodostojan i proverljiv sadržaj. 

Pravila korišćenja YouTube kanala 

YouTube kanal podstiče slobodno izražavanje stavova ali izričito zabranjuje postavljanje uvredljivog 

sadržaja i govora mržnje (koji napada ili ponižava grupu na osnovu rase ili etničkog porekla, religije, 

invaliditeta, pola, uzrasta, statusa veterana i seksualne orijentacije / rodnog identiteta ). 

5.2 Kreirajte sopstveni kanal na Youtube kanalu 

Privatni kanal na YouTube-u je vaš javni profil, koji vam omogućava davanje komentara na sve 
filmove koje budete gledali, kao i čuvanje filmova u plej-listi. Bez privatnog kanala, možete se samo 
prijaviti (subscribe) na druge kanale i ostavljati komentare u vidu like ili dislike. 

Ukoliko imate već otvoren privatni kanal dovoljno je samo da se prijavite (Sign in) sa svojim 
korisničkim parametrima (Slika 1). 

 

Slika 1 
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Ukoliko nemate kanal na YouTube-u prvi korak je da napravite nalog na nekom od Google servisa. 

Odaberite bilo koji od servisa ili zvanični sajt www.google.com i idite na opciju Create account. Osim 
podataka kao što su Ime naloga (Name), username i password potrebno je dati i bilo koji validni 
telefonski broj na koji vam stiže kôd koji unosite pri drugom koraku u kreiranju naloga (Slika 2). 

 

 

 

Slika 2 

http://www.google.com/
http://www.google.com/
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Sa formiranim nalogom otvorite YouTube veb stranicu na adresi www.youtube.com. Prijavite se, a 
zatim i pretražite kanale na YouTube-u, koji bi možda bili interesantni za vas. Kada pronađete kanale 

kliknite na Subscribe, na taj način se prijavljujete na kanale sa kojih će vam stići obaveštenja o svim 
novim filmovima. 

Pronađite kanal i pretplatite se 

 Prijavite se, a zatim pregledajte kanale koji bi možda bili interesantni za vas; 

 Pronađite kanal koji vam se sviđa, a zatim kliknite na Subscribe (Slika3); 

 Kada se pretplatite na kanal, dobijaćete ažuriranja na YouTube početnoj stranici svaki put 
kada taj kanal objavi novi video zapis. 

 

Slika 3 

5.3 Sačuvajte filmove koje želite da pogledate kasnije 

Dodajte željene filmove na plejliste kako biste ih kasnije lakše pronašli sa bilo kog uređaja sa koga 
pristupate YouTube-u. 

Plejlista Watch Later olakšava pronalaženje video zapisa koje želite da sačuvate i pogledate kasnije: 

 Zadržite pokazivač iznad ikonice video zapisa, a zatim kliknite na ikonu sa satom kako bi se 
video zapis automatski dodao na vaš popis Watch Later (Slika 4). 

 Kako biste video zapis dodali na popis Watch Later na stranici video zapisa, kliknite na ikonu 

sa satom u plejeru. Lista će se pojaviti s desne strane YouTube plejera. 

 Kada je video dodat Watch Later listi, ikonica sata na samom videu biće zamenjena zelenom 

kvačicom (Slika 5). 

 Da biste videli svoju Watch Later listu, kliknite na opciju Watch Later u meniju sa leve strane 
(Slika 6). 

 

Slika 4 

Formulari/www.youtube.com
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Na samoj stranici odabranog videa, kliknite na ikonicu sata u plejeru i time ste automatski dodali 
video u  Watch Later listu. Lista će se pojaviti desno od YouTube plejera. 

 

Slika 5 

 

Slika 6 

 

5.4  Otpremanje video datoteka na Youtube sa lokalnog računara 

Postoje tri načina za otpremanje video datoteke na Youtube:. 

1. Možete koristiti veb kameru priključenu na vaš računar, snimati video i direktno izvršiti 
otpremanje video datoteke na Youtube.  

2. Video možete snimiti koristeći i smartphone - pametne telefone (kao što su Android ili IPhone 

uređaji). Zavisno od uređaja koji koristite, moći ćete da direktno postavite vaš video na Youtube 
koristeći samo telefon.  

3. Snimljeni video sadržaj sa bilo kojim tipom video kamere možete prebaciti na vaš računar, a zatim 
ga objaviti na  Youtube.  
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Da biste uspešno otpremili video datoteku morate da ga sačuvate u formatu koji Youtube podržava. 
Najčešći formati video datoteka su:  

 WebM datoteke  

 .MPEG4, 3GPP i MOV datoteke   

 .AVI  

 .MPEGPS  

 .WMV  

 .FLV  

 

Prvi korak je klik na dugme Upload (Slika 7) 

 

Slika 7 

Postoji limit od 15 minuta koliko može da traje bilo koji video postavljan na Youtube. Ipak, možete da 
povećate ovaj limit klikom na link Increase your limit na stranici za upload (Slika 8). Potrebno je da 
unesete broj mobilnog telefona za proces verifikacije.  

 

Slika 8 
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Proces postavljanja videa započinjete klikom na strelicu u centralnom delu ekrana, odnosno 
odabirom videa na svom računaru (Slika 9). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Slika 9 

 

Pojaviće se traka na kojoj možete videti kojom brzinom se video otprema, kao i više polja u koje 
možete da unesete informacije o vašem videu. 

Title – naziv videa u koji se automatski upisuje naziv same datoteke koji postavljate, a koji možete i 
da promenite; 

Description – ovo polje porazumeva kratak opis sadržaja video datoteke; 

Tags – u ovom polju je potrebno upisati pojmove koji su povezani sa sadržajem videa i po kome se 
video može pronaći u pretrazi na YouTube kanalu. 

 

5.5 Postavljanje video datoteke na Youtube sa veb kamere 

Ako želite da direktno snimate video veb kamerom i izvršite otpremanje na YouTube kanal, na 

stranici za upload kliknite na opciju Create videos – Webcam capture (Slika 10). 
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Slika 10 

Otvara se prozor za autodetekciju vaše veb kamere. U samom prozoru se pojavljuje dijalog na kome 

klikom na Allow dugme dozvoljavate pristup vašoj veb kameri i mikrofonu (Slika 11). 

  

 

 

 

 

 

 

 

 

 

Slika 11 

Kada čekirate opciju Allow  pritisnite crveno dugme u dnu (Start recording) i počinjete sa snimanjem, 

Da bi završili snimanje kliknite na opciju Stop recording (Slika 12). 
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Slika 12 

Pojavljuje se u krajnjem desnom uglu dugme Upload , tako da možete direktno izvršiti postavljanje 

videa na svoj kanal. Ukoliko smatrate da treba da ponovite snimanje možete kliknuti na crveno 

dugme u sredini Start over (Slika 13). 

 

 

 

 

 

 

 

 

 

 

 

Slika 13 



 

 
58 

Obratite pažnju da morate popuniti polja koja se odnose na naziv video datoteke, opis kao i pojmove 

po kojima se ovaj video može pretraživati na YouTube kanalu. Na kraju kliknite na dugme Save 

changes u gornjem desnom uglu vašeg radnog prozora (Slika 14). 

 

 

Slika14 

Ako želite da uklonite neki od filmova sa svog kanala, kliknite na opciju Video Manager (Slika 15) 

Otvara se radni prozor sa otpremljenim filmovima. Pored svakog se nalazi opcija Edit. 

 

Slika 15 
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Otvara se radni prozor sa otpremljenim filmovima. Kada kliknete na opciju Edit pored svakog filma 

otvara se padajući meni sa raznim opcijama u kome je poslednja Delete (Slika 16). 

 

Slika 16 

Ako želite da preuzmete ovaj film kao MP4 datoteku u istom meniju kliknite na opciju Download 

MP4. 

5.6 Autorska prava korišćenja i postavljanja video zapisa na YouTube 

Na YouTube kanalu postoji uputstvo o poštovanju autorskih prava. Kada korisnik smatra da je 
njegovo delo zaštićeno autorskim pravima postavljeno na YouTube bez ovlašćenja, korisnik može da 
pošalje obaveštenje o povredi autorskih prava. Te zahteve može da podnosi samo vlasnik autorskih 
prava ili ovlašćeno lice. YouTube ne može da posreduje u sporovima o vlasništvu autorskih prava, već 
samo da na obaveštenje o povredi prava, ukloni sadržaj u skladu sa zakonom. 

Najbrži i najjednostavniji način za obaveštavanje YouTube kanala o navodnoj povredi autorskih prava 
je preko veb-obrasca koji se nalazi na kanalu YouTube. 
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6. Zaključak 

Odlika današnjeg globalnog informatičkog 
društva je posedovanje informacije kao 
osnovnog sredstva  svakog čoveka za 
snalaženje ne samo u poslovnom, nego i u 
svakodnevnom životu. Medijska 
pismenost postaje deo opšte kulture, a 
značajna uloga medija potvrđuje se u 
svim oblastima društvenog života i rada. 

 

Kreiranje multimedijalnih materijala, najčešće filmova nije više 
samo posao za profesionalce, već je postalo dostupno i za 
obične ljude. Društvene mreže i specijalizovani kanali sa 
objavljivanje video sadržaja, kao što su Youtube, Facebook, 
LinkedIn, Twitter su postale sastavni deo savremenog 
poslovanja, marketinga, promocije očuvanja životne sredine, 
kao i popularizacije svih sadržaja koji se bave očuvanjem 
kulturne baštine.  

 

U moru sadržaja, potrebno je edukovati sve generacije kako da sadržajima pristupe, kako da kreiraju 
svoje i kako da, kao aktivni članovi svih takvih zajednica, pošalju svoju poruku i budu deo nekog 
pokreta. 

 

 

 

Ovaj priručnik je pokušaj da se u jednom optimizuju sva potrebna znanja za korisnika koji počinje od 
samog početka, svog računara i dobre volje da kreira i stvara.  

 
  


